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Agenda Resources 

• Online Help and Tooltips 
{update to mention iDev tutorial DVD + Help integrated into iDev, plus vHCS:View & iView 

Help. What’s the iDev equivalent of tooltips for ranges, etc?} 

• Users Guides 
A disk containing PDFs for operation of the ArrayScan and BioApplications was included 

with your shipment.  Best used as detailed reference documents. 

• Cellomics Technical Support: (800) 432-4091 

 or HCSTechnicalSupport@thermofisher.com   
• Always contact Tech Support FIRST.  FAS may be unavailable (e.g., training), it may 

be a hardware malfunction requiring an engineer, and/or it may be an IT matter in 

which your FAS has limited expertise. Tech Support will triage as appropriate. 

• To contact Technical Support, please take note of: 
• Build number of your software: Build ___________________________ 

• Serial number of your VTi, using the last 3 digits 

of your instrument’s serial # (see tag on instrument):  ________________________ 

• Reagent technical support :  perbio.eurotech@thermofisher.com  

• HCS Reagents Technical Support: 800-874-3723 is the place to go for answers to  

Cellomics assay kit questions not found in ClubHCS 

• Your FAS (Field Applications Scientist): _____________________________________ 

 

 mobile __________________  email __________________________ 

• Your FAS knows all Cellomics products, Wants to know your biology & applications, 

& can recommend certain BioApplications for certain tasks, much more expedient 

than your learning the details of all BioApplications. 

• Your Key Account Manager 
• This Sales professional is dedicated to your success and meeting your needs: 

 

 

 ___________________________     ___________________________________ 

 

Day 1 
• Resources review, system overview, 

Getting Started, & terminology 

• Overview of Workflow- load YOUR 

training sample plate, select an assay 

protocol, acquire images, optimize assay 

protocol for 1st pass, scan plate, review 

results 

 

Day 2 (ArrayScan VTI only) 
• Dive deeper into the Assay Protocol: All 

input settings and how they’re saved, 

more on optimizing 1st-pass settings for 

2nd pass, etc. 

• Interactively developing 2nd-pass input 

settings for a training sample. Execute 

2nd-pass scan analysis. 

 

Overall Aim: Load sample plate, develop 

input settings for imaging & primary 

analysis according to Best Practices for 

HCS. 

– A sample plate should be analyzed, and 

at least a preliminary review of results 

completed. 

mailto:HCSTechnicalSupport@thermoficher.com
mailto:perbio.eurotech@thermofisher.com
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HCS Data “Quality” 

• “GIGO”: “garbage in, garbage out” 

• HCS assay data’s “legitimacy” depends on the suitability & 

quality of an assembly of steps. 

• “A chain is as strong as its weakest link.” 

• Quality and suitability of… 

specimen image 
analytical input 

(parameters) 

output 

(features) 

 After good sample preparation is achieved, the 1st step 

in HCS is getting a suitable image. But this is 

circular/bidirectional between adjacent links… 

specimen  image  image analysis input  

output 

Typical assay development principles apply: 

The outputs are not meaningful unless the inputs are. 

Certain input/outputs can be progressively optimized. For 

example, Reference Level-based, derived, non-intrinsic 

features (e.g., %HIGH_, %Responders, %<2N…) can be 

attended to after “raw”, intrinsic features are solidly based on 

robust input settings. 

• HCS principles don’t differ from scientific assay 

development generally: 

• maximize/optimize signal:noise ratios 

• maximize/optimize max:min response windows 

• maximize/optimize speed vs. resolution of S:N & max:min 

• …these are determined by sample quality, imaging, 

and analytical input parameters 

• images’ foreground:background  output max:min 

responses 

• images’ foreground:background depends on both… 

• specimen quality, including labeling reagents and 

support matrix (e.g., plastic vs. glass well bottoms) 

-and- 

• imaging exposure times (eventually, background will rise 

with foreground, approaching point of “diminishing 

returns”) 

• output max/min response windows depend on both … 

• image foreground:background (sample quality, exposure 

times, etc.) 

-and- 

• analytical input parameters 
 

imaging exposure 

time 

image 

fore- : background 

max:min output 

window 
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A Brief Cellomics Glossary 

• Object- the item(s) in an image that you 

wish to analyze.  This can be a cell, a 

nucleus, a colony, or an organism 

• Object Identification- the process of 

determining which pixels in an image are 

part of an Object or part of the Background.  

This is done by creating or modifying a 

Threshold. 

• Threshold- the intensity value that 

delineates object pixels from background 

pixels. Maybe specified directly or indirectly. 

• Field- from microscopy’s “field-of-view’- the 

area of a Well visible by the camera 

• Channel- a collection of image acquisition 

settings for a single image; including 

exposure time, Dye selection (wavelength 

filter configuration) 

• Image Set- one or more images acquired 

from a single field, comprising one image 

per channel 

• Primary Object- generally the objects in 

the first Channel 

• Sub-objects- an informal term for objects 

that belong to a primary object- such as 

neurites or spots assigned to a single cell. 

• Object Segmentation- the process of 

separating objects that are very close to 

one another, for the purposes of analyzing 

them individually 

• Parameter- generally, an input that you 

make to the software 

• Feature- an output data point based on the 

image and data analysis process 

• Cell Features- numeric data points describing 

the measured properties of a single Object 

• Well Features- numeric data points describing 

the measured properties of a Well of 

cells/objects- most often, statistical 

calculations (Mean, SD, % responders, etc.) 
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Data Hierarchy and Tiers 

Many terms in HCS have historical roots that are blends of 

photographic imaging and cell-based screening. Often the 

vocabulary works well, but is not a restriction on capabilities. 

• Plate level features- E.g., exposure times, z-offsets, 

Reference Levels. This “plate” structure is rooted in cell-based 

assays in multi-well microtitre plates. In HCS, it can mean a 

microscope slide, too. 

• Well level features- E.g., Z-position, CellCount, 

MEAN_ObjectAvgIntenCh2, SD_ObjectTotalInten, 

%HIGH_RingSpotCountCh2. A well is merely a subdivision of a 

plate. It constitutes a container for materials delivered to it. It 

can also be a subdivision of a micro-slide. 

• Fields- A term borrowed from microscopy’s “field of view”. 

When a Field size is smaller than the image-able surface of a 

well, multiple fields may be imaged per well. Some 

BioApplications report Field features. All report Cell Features 

linked to Wells+Fields. 

• Cell level features- E.g., ObjectSizeCh1, 

RingSpotCountStatusCh2. Historically, it was cells that were 

plated into wells of a plate. In HCS, the fundamental unit of 

analysis (primary Object) is most often a Cell, and multiple 

features of it are measured. Some of these features may be 

sub-objects (e.g., spots, micronuclei, perinuclear rings, 

neurites), though not necessarily. So, Cell Features are a class 

in this hierarchy, but Cell Features may correspond to 

properties of colonies or whole organisms (e.g., C. elegans). 

• “Intrinsic/raw” Cell Features- e.g., RingSpotCountCh2 is a 

mere count of how many spots have been ascribed to an object 

based on sub-objects (spots) identified by Ch2’s label within a 

sub-compartment (ring) of an object. 

• “Simple Statistical” Well Features based on intrinsic/raw 

Cell Features- e.g., MEAN_TargetAvgIntenCh2 of a well’s 

population of objects is simply computed from the values for 

every selected object’s corresponding cell feature 

TargetAvgIntenCh2. That mean has a  SD_TargetAvgIntenCh2 

about it, too. ObjectCount is another example; it’s the sample 

size, n, on which the mean, stdDev, etc., are based. 

• Status Cell Features- e.g., RingSpotCountStatusCh2. In some 

BioApplications, an object can be assigned to one of some Cell 

Feature phenotypes. For example, if an object’s 

TargetIntenCh2 exceeds the corresponding Reference Level, 

it’s classified by TargetIntenStatusCh2=1; else =0. 

• Population Characterization Well Features based on Status 

Cell Features- Rather than a metric of a mean response, these 

report the fraction of a well’s sampled population that fall in a 

phenotypic class.  E.g., %HIGH_TargetAvgIntenCh2 reports 

what percentage of the well’s sampled population exceeded a 

minimum Response Level. It’s simply computed by tabulating 

the corresponding Status frequencies. 

• The meaning & legitimacy of intrinsic/raw features depends on 

the quality of input settings that generate them. The same is 

true of Population Characterization features. the %HIGH value 

is not meaningful if relevant Reference Level inputs were not 

used. 
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Anatomy of a Generic Cell 

Circ Ring 

Primary Object = Nucleus 

Circ  

Spots 
Ring  

Spots 

Ch 1 Ch 2 Ch 3 or 4 

Primary Object = Whole Cell 

Process Members SpotFibers 

(high LWR) 

Ch 1 Downstream Channels 

SpotFibers 

(low LWR) 

Special Design for Morphology Explorer 

Object 

Object 



7 

Primary Object (Nucleus) 

Channel 1 

Mask Modifier 

-2.0 

Mask Modifier 

-4.0 
Mask Modifier 

+ 2 

Mask Modifier 

+ 4 

Masks and Modifications 

• Mask:  the graphic representation of an object that is applied to separate channel in order to make a 

measurement in that channel 

• Mask Modification:  the enlargement or shrinking of the original mask 

• Positive values for the Mask Modifier parameter enlarge the mask (dilation) 

• Negative values for the Mask Modifier parameter reduce the size of the mask (erosion) 

• Three major types of Mask Modifications: 

• Primary object mask (MaskModifier) 

• Circ Mask (CircModifier) 

• Ring Mask (RingDistance and RingWidth) 

• The value of the Modifier is the number of pixels to dilate (positive) or erode (negative) the mask 

 

• Adjustment of Mask and Circ Mask looks like this: 



8 

Adjustment of Circ & Ring Regions 

 

PRIMARY 
OBJECT 

RING 

Ring 
Distance 

PRIMARY 
OBJECT 

CIRC 

Ring  
Width 

Circ 
Modifier 

CELL CELL 

• Ring Mask is described by 2 parameters:  Ring Distance and Ring Width 

• Adjustment is always relative to the Primary Object Mask 
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Getting Started 

1. Power on instrument. 

• ArrayScan VTI: Single green switch on right side  or 

front of instrument. (For VTI Live cell chamber 

module, see Appendix.) 

• Cell Insight:  

2. Power on computer. 

• Order of 1 & 2 does not matter. But… 

• Do NOT power off instrument (or components) while 

Scan software is open. 

• If do, close software & re-boot computer. 

3. Log on to Windows on the computer: 

• May not be able to use same login as at your desk 

PC. 

• May need to be part of a Cellomics domain group. 

• Only YOUR network administrator/IT support staff can 

help you with this. That person is: 

 

____________________________________ 

THIS LOGIN IS VERY IMPORTANT for full 

functionality. 

• Never let IT staff change name of computer 

without consulting Cellomics. Some functions (e.g., 

licenses) could be lost & require full re-installation. 

4. Launch Cellomics software. 

a) Instrument: Shortcut like “Cellomics ArrayScan 

Instrument” or “Scan” 

To start software in Disk Mode, have instrument powered 

off. (or add –canned to shortcut Target) 

b) vHCS:View 

• Either (a) or (b) will prompt you for a Cellomics login. 

• NOT same as Windows login. 

• Default is “cell/cell”. Yours?: ______________________ 

• Your system admin may have/should set up each user with 

their own Cellomics login (see ArrayScan/Scan 

Administrator tab in the ArrayScan/Scan Operator’s Guide) 

to personalize your files, results, & activities on the 

Cellomics system. 

• NOT a secure (as Windows or your network’s) login, so 

keep simple, and know that others can see it. 

5. Suspect problem? Use HCS Administrator software. 

• If some Cellomics software behavior is suspect, launch your HCS 

Administrator> Diagnostics> Run Diagnostics. 

• All Results? You’re OK. Otherwise, may need your IT staff’s support. 

Email Report, or drag down row buttons to select all, then Ctrl+C to 

copy (then paste and email, etc.). Or PrntScrn keyboard button (then 

paste, etc.) 

• Diagnostic results also useful for learning AppSvr name, acct name, 

network bandwidth, server path & free space, database name & 

location… 
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How it works on the ArrayScan VTI 

Camera 

Tube Lens 

Objective 

Z Motor 

A
p
o
to

m
e

 

Wide field 

Light Source 

(EXFO or LED) 
Apotome 

(Optional) 

Filter Cube 

(Dichroic Mirror & 

Emission Filter) 

Prior to the Confocal Module, 

normal widefield mode uses 

an epifluorescence light path 
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Scan Login Screen – iDev vs Classic 

After login, to change modes, use 

View> Mode> 

Choose iDev or 

Classic during 

login. 

 

This booklet is 

iDev-focused, so 

choose iDev. 

What’s saved as an Assay Protocol? 

• Objective (magnification) 

• Imaging resolution 

• What color fluorophores to image 

• Exposure (CCD integration) times 

• Autofocusing settings 

• How many images taken per well 

• BioApplication image processing algorithm settings 

What’s NOT saved in an Assay Protocol? 

• Plate Type Form Factor 

• Which wells of a plate to analyze 

• Which field of a well to start in 

• Whether to save images 

• Maximal image displays during scan 

• Reference Well selections 

“Assay Protocol” 

After login, you start in the Scan Plate window, which 

presumes you are an experienced user – an inappropriate 

place to begin training. Click the iDev button shown at right 

to go to the Select Protocol window of iDev Workflow. 
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Software divided into two areas: iDev Workflow task list (& Task Description), and the selected task’s workspace 

(specific to each task).  

 

Primary tasks in the iDev Workflow list can be selected either by clicking a line in the list, or the [Next] button at the lower 

right. 

 

Only ≥V4 protocols are compatible with iDev. The Select Protocol dialog (a.k.a., Protocol Manager; shown above, after 

clicking [Change…]) can be used to upgrade from prior versions (select a protocol, right-click, Upgrade…). 
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Protocol Manager 

Protocols 

sorted by 

bioapps    

then sub-

sorted by 

user account 

(select and right click on the 

protocol) 
Html version of 

protocol 

Suitable format for 

analysis (to send to 

your collaborators 

or FAS) 

Upgrade 

protocols after 

bioapplications 

upgrade 

Show differences between 

selected protocols 

Rollback button allows to 

replace the most recent 

version of the protocols by 

the selected version 

Display only 

protocols that 

have been 

developed by 

your user 

account (login 

in IDev) 

Display only 

protocols that 

are 

compatible 

with the 

BioApp 

version. 

Warning: 

protocols 

may not be 

visible after 

an upgrade if 

this option is 

activated 

Directly import or export protocol 
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(Images appear in this space) 

Common sequence: 

1.Choose well & field. 

2.[Autofocus] 

3.[Acquire Image Set] 

4.[Save Field] 

Common purpose: 

Temporarily save images (all 

channels) from several wells 

and/or fields, to be used for 

setting image analysis 

parameters next. 

Note titles of 3 top-level 

divisions in this window. 

Details about settings in 

the Image Acquisition 

and Channel Specific 

Parameters panes are 

presented later. 

(A) In the Acquire 

pane, verify or 

[Change…] the Form 

Factor.  

(B) To load sample, 

click [Load Plate] on 

highest menu bar. 

[Retract Plate] after 

placed. 

(C) Set/verify exposure 

parameters (detailed 

later). 

(D) Acquire Image Sets 

& Save Fields as 

described at left. 

 

Details about settings and controls in this window are presented in 

subsequent sections of this guide. Although the images saved by [Save 

Field] are only stored temporarily, all settings in Image Acquisition and 

Channel Specific Parameters panes are saved in the Assay Protocol.  

(Nothing in the Acquire pane is saved ‘permanently’.) 
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Contrast Options – common illusory image comparisons! 

• There are only 2 images on this page – top & bottom row. Across each row 
are different display adjustments of the respective image. Top row’s field 
was directly adjacent to the field in the bottom row! 

• In 1st column – Full or Max – do you think the bottom field is dimmer? Do 
the 12-bit histograms suggest that? 

• The 1st column illustrates the common illusion of Contrast-Stretching—an 
auto-adjustment of brightness/contrast done on an image-by-image basis. 
Contrast-stretched images canNOT be legitimately compared for visual 
intensity differences! 

(In Brightness Clip controls elsewhere, Full (the default) = “Automatic High & 
Low Input Clip”, Max = “Automatic High Input Clip”.) 

• Beware: Full Contrast Stretch is the default display adjustment! 

• For image-to-image intensity comparisons, Contrast-Stretching 
should be deactivated, and Bits-To-Display selected. 

• Histograms under images are 8 bits—256 gray levels—the maximum 
# of grays display-able on a monitor. Bitshift 3 (i.e., bits 3-10, or 
grays 8-1024 from the 12-bit source image) illustrates the best 
spread of the gray levels across the 8 display bits. For the top field, 
Bitshift 4 resembles the Contrast-Stretched image, whereas for the 
bottom field, it’s Bitshift 5. 

(In Brightness Clip controls elsewhere, Input Clip Mode = Manual is 
used instead of Bits-To-Display bitshifts.) 

12-bit histogram 
y auto-scaled 

12-bit histogram 
y stretch zoomed 

12-bit histogram 
y auto-scaled 

12-bit histogram 
y stretch zoomed 

to see low 
frequency pixels 

• In the bottom field, the bright spot shows 

up on the 12-bit y-stretch histogram. 

When auto-re-mapped to 8 bits, those 

high values prevent expansion of the 

display histogram. 

Display Options or 

8-bit histograms 
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Channel Specific Parameters- “Dye” (filter) 

Label: Merely ‘free-form’ text to serve as 

image captions in later windows. 

Illumination Correction: Advanced topic. 

Regular use unnecessary. 

• Consult Appendix B of the User’s Guide 

tab within your Operator’s Guide binder, 

which explains why scans are faster if all 

fluors in a sample can be imaged by the 

same XF or BGRFR set. 

• All else being equal, Cy5 channels are 

usually the weakest (because of both 

excitation and detection optics). Therefore, 

use a Cy5-like dye only if a 4th color  is 

needed, and use to label/ report the most 

abundant target, etc. 

• Other dyes/fluorophores are certainly 

possible; consult Cellomics Support or 

online filter sites. 

Dye/ Fluorophore Color Classes   

Hoechst 

(_386_23) 

FITC 

(_485_20) 

TRITC 

(_549_15) 

Texas Red 

(_572_15) 

Cy5 

(_650_13) 

DAPI fluorescein rhodamine DRAQ5 

  GFP, EGFP Whole Cell Stain 

Orange   

 Whole Cell Stain 

Red 

 Whole Cell 

Stain Blue 

Alexa Fluor
®
 488 

Whole Cell Stain 

Green 

Alexa Fluor  546 

Alexa Fluor  555 

Alexa Fluor  594 

~Alexa Fluor  568 

 

  YOYO®-1 

YO-PRO®-1 

SYTOX® Green 

DyLight™ 549 

~BOBO™-3 

Cy3™ 

 

~YO-PRO™-3 

~SYTO®17 

Alexa Fluor  647  

~TOTO
®
-3 

Coumarins Fluo-4  

Calcein 

BODIPY®-FL 

Dil (DiIC18(3)) 

BODIPY-TMR 

  DiD (DilC18(5)) 

  XF100 

BGRFR  

XF93  XF53  XF32 XF110 

Hoechst (_386_23) good good good 

FITC (_485_20) good good good 

TRITC (_549_15)   good   sensitive 

Texas Red (_572_15)     good 

Cy5 (_650_13)   good sensitive  
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Exposure Type:  Fixed Exposure Time vs AutoExpose 

• Key image analysis steps are tightly dependent on image characteristics that are, in turn, largely determined by exposure 
times. 

• Matching exposure times to existing input analysis parameters is often more productive than adjusting the more 
numerous analysis parameters. 

• Instrument components change over time, so AutoExpose Options that can compensate will prove useful, even 
when the preferred Fixed method is selected and used during plate scanning. 

• ArrayScan/vHCS:Scan Classic only (not iDev): Even when stored images are re-loaded, their % of dynamic range 
will be reported by the Autoexpose routine. 

“Target” guidelines for what % of dynamic range (“Peak Target”; see next page) may be suitable for types of fluorescence 

labels. 

25%: Good for mainly “structural” labels (e.g., counter-stained nuclei). Still affords some range for differentiation between, e.g., 

interphase, mitotic/apototic nuclei. ~20% can be tried for minimizing autofocus time & maximizing speed. Typically also 

sufficient for “binary” assays where the interest is whether the label is there or not, yes/no—e.g., mitotic index, negative 

viability (“dead dyes”), micronuclei, and others. 

35-40%: For “intensity” quantifications. Also reasonable starting range for “structural+intensity” labeling—e.g., nuclei in assays 

needing more discrimination (e.g., DNA content/cell cycle). 

55-65%: Good for multi-modal structural labels where accurate identification of more than one intensity level is of interest—e.g., 

some neuronal cell bodies are considerably brighter than neurites that also must be accurately identified. High dynamic range 

may also be required for some indicators of cellular metabolism, physiology, health, etc. 

Best Practice: When trying higher %, be on guard for saturation. Optimal exposure ranges are worth careful investigation. Large 

improvements often emerge particularly in “intensity” assays. If your BioApplication has multiple channels measuring the same 

thing, fill them all with variable exposure times during assay development pilots. 

• Fixed Exposure Time:  Specified time for a channel is used throughout imaging and scans. This is the recommended 

method. 

• AutoExpose:  still must specify an Initial Exposure Time, which will be used as a starting point to automatically determine a 

time that meets your AutoExpose Options. This method is not recommended until you completely understand this process 

(see below). 
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Recommended default practice for setting exposure times 

1. In your Autofocus channel, set… 

2. Exposure Type = Fixed Exposure Time 

3. Exposure Time = 0.1 sec (in absence of better 

knowledge) 

4. [AutoExpose Options…] 

a. List of wells to Autoexpose = a1 

b. List of fields to Autoexpose = 1 

 (The above 2 settings are irrelevant for Fixed Exposure Type, 

but the software requires an entry to access the remaining 

settings.) 

a. Method Name = Peak Target(Percentile) 

(the different methods are summarized on next page) 

b. Target = {per Target guidelines on prior page} 

c. Tolerance = 2 % 

d. Skip Percent  0.5 %         

e. Max Exposure Time = 2 Seconds 

f. Max Iterations = 8 Attempts 

5. [OK] 

6. Get an in-focus image (you may need to adjust Exposure 

Time if AutoFocus fails) from a well appropriate to Target 

guidelines (e.g., if this is an “intensity assay” type of 

channel, choose wells where the brightest signal is 

expected). 

6. Is this a “representative” image, in your experience?  

If current field is unusual (many outlier bright regions, sparse, 

overgrown, dark…), find another more representative field. 

7. Image Saturation [bar]: Is it green (i.e., within Tolerance of 

Target)?  

a. If no, [Auto Expose] (one click at a time until bar is green). 

b. If yes, test that a few other representative fields are close to the 

Target (±5-10% is normal variation). 

c. Each time you click [Auto Expose], the Fixed time changes, so be 

reasonable with expected variation, note the time differences each 

time you click [Auto Expose], and consider a happy medium. 

8. Test your accepted exposure time in multiple fields of multiple 

wells, especially spanning experimental conditions where 

brightness differences might be expected. 

9. Repeat for all other channels, changing the Target according 

to Target guidelines if necessary. 

Save all these exposure settings with your Assay Protocol. If the 

quality of your samples changes at later dates, you should 

merely repeat this process of clicking [Auto Expose], so that 

your images span a similar dynamic range as your original 

sample(s). 
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AutoExpose Options 

1.Whereas Background Target(Mode) Method refers to 

image histograms, “Peak” does not refer to a 

histogram peak; after Skipping specified brightest 

pixels, Peak is histogram’s X-axis intensity of 

remaining brightest pixel. “Max Intensity” 

2.Peak methods good for targeting brightest signals as 

% of camera’s 4095 grey-level dynamic range. 

3.Background… method: When signal is expected to be 

absent, still can get useful exposure time (typically low 

% so when fore-ground appears in unknowns, it 

extends into useful range). 

AutoExpose Options: caveats & best practices 

If a scan is executed with an Assay Protocol specifying AutoExpose as Exposure 

Type, before the whole scan begins, the system… 

1. Goes to 1st well in List of wells to Autoexpose. 

2. Goes to 1st field in List of fields to Autoexpose. 

3. Autofocuses (using Configure Focus…> Autofocus Options> Camera 

Exposure Time> Focus Exposure Time For Autoexpose—note, AutoFOCUS 

setting!). 

• If Autofocus fails, so does that field! Proceeds to next. 

4. Execute Autoexposure Method. 
a) Failed any channel? Try in next specified field  

(i.e., in example, field 5 is used only if field 4 fails). 

b) Succeeded for all channels? Temporarily hold determined exposure time(s) in memory. 

5. Go to next well, as applicable, repeat, hold time. 

6. Compute mean of all “held” times (i.e., where succeeded) & use it for 

respective channel(s) for whole plate scan. 

Benefits: 

• If reagents, optics, etc. vary over time or from plate to plate, this Exposure 

Type may be compensatory. 

Caveats: 

• No automatic way to know if specified wells/fields are in good condition in 

every plate. And final exposure time(s) is only from successful wells. Images 

from AutoExpose are not saved. 

• Screeners may want not to have assay variables masked by system 

compensations. 

• Users need to remember what Assay Protocols have set as wells/fields to 

autoexpose and whether the same for every plate used with that Protocol.  
An Intermediate – Best Practice:  Use [Autoexpose] button in Configure Acquisition on 

fields deemed representative by you, but specify Fixed ultimately in the saved 

Assay Protocol.  
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Image Acquisition  pane 

1. Objective: Lenses installed on system appear in drop-down list. 

To install different objective: Handle objectives with great care (expensive 

to replace), and avoid touching glass lenses with fingers or otherwise 

scratching.  

• ArrayScan VTI: Close ArrayScan software if open. Then, Windows 

Start button> All Programs> Cellomics> Objective Change Wizard. 

Follow instructions. 

• Cell Insight: Tools> Maintenance> Move To Objective Change 

Position.  

Later Configure Assay Parameters task, understand benefit of Use 

Micrometers Option menu command and impact of Objective setting on 

area- & length-based features and Selection Parameters. See 

BioApplication Guides. 

2. Camera Configuration- on an Instrument you will have only one choice; on 

Toolbox clients choose the camera that you have or plan to acquire images 

with. 

3. Acquisition Camera Mode: Generally, “Standard”.  

(Specifies image resolution by on-camera pixel binning during image 

acquisition. Under guidance of Cellomics support, HiRes may be suggested 

for greater pixel resolution, but longer exposure times [e.g., 4-fold vs 

Standard] are needed [potential bleaching], image processing may be up to 4-

fold slower, so overall scan times will be slower.) 

4. # Channels: BioApplication-dependent: For some, the standard # of channels 

can be scaled back, and/or additional “gating” channels can be added. See 

BioApplication Guides. 
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c) Intra-well Autofocus Interval 

• “on first field only” rarely recommended. Autofocus Interval is illustrated in your User’s Guide (within Operator’s Guide). 

• Determines the points within a well where a focus adjustment is performed.Conservative generalizations to start:  

4 fields@5x   3 fields@10x   2 fields@20x   1field@40x. 

• Affects scan times & quality, depending on #fields scanned per well (Scan Limits). 

a. Therefore, best optimized during development of an assay by careful review of all images acquired during a scan 

 (at least review images from wells with highest # of fields acquired). 

b. Variables to consider include  

1. sample’s cell density (too sparse? “empty” fields take extended time) 

2. sample’s quality (occasional debris or stacked cells? maybe more frequent Interval) 

3. objective magnification and NA (inversely proportional to Interval) 

4. standard- or thin-bottomed plates (thin wavier? maybe more frequent Interval) 

5. plate’s well density (384, 96, etc.; esp. if thin-bottomed, lower density wavier) 

6. users’ and algorithms’ analytical tolerances… 

d) Configure AutoFocus Parameters… Generally, use defaults. 

• Autofocus may consider a Focus Channel image out-of-focus (/sparse) & prevent BioApplication analysis (though save the 

field’s images). AutoFocus Method = RELAXED or ASV40SF avoids this interception (the case for all Disk Scans, since 

Autofocus isn’t used). 

• AutoFocus Method = RELAXED or ASV40SF may be useful when: 

1. High-NA objective on standard thick plates (see User Guide Appendix "Plate Types & Objective Selection"); 

2. Object intensities in Focus Channel vary widely; 

3. Sparse fields are potentially common; 

4. Multi-layer cells are potentially common; 

• AutoFocus Method = RELAXED or ASV40SF also have additional effects (e.g., focus accuracy may be less), so it’s not 

recommended as default. 

AutoFocus settings 

a) Use This Channel For Autofocus: Generally, choose a channel imaging a dye whose quantitative fluorescence is not critical 

and/or is relatively photostable (e.g., a nuclear Hoechst stain for demarcating the nucleus). 

b) Autofocus Camera Mode:  “AutoFocus” often specified in default Assay Protocols. “Standard” may yield faster scan times if 

Acquisition Camera Mode also Standard, but depends on samples imaged in Focus Channel; determine empirically or consult 

Cellomics Support. 
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Configure Focus 

Do not change 

configurations 

here unless you 

have been 

advised by a 

TechSupport 

member (FAS, 

engineer…) 

(see on next slide) 

Add a focus adjustment to the focal 

plan determined algorithmically 
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[Next] to Configure Assay 
Parameters | Live- vs Disk-mode 

When have I used [Save Field] enough in the 

Configure Acquisition task to go [Next] to the 

Configure Assay Parameters task? 

Answer: When you have representative sampling of 

your assay development sample. To answer this 

question reasonably… 

1. You have to be familiar with your assay development 

sample, such as the variation from field-to-field (if 

any) and well-to-well, in both positive and negative 

controls, etc. 

2. You have to appreciate the subsequent tasks in the 

workflow, especially… 

You have to understand Groups in the Configure 

Assay Parameters task. 

1. A Group can contain no more than 10 fields (“entities” 

are fields), whether from different wells (or the same), 

and/or different plates (see Disk mode at right). 

2. Fields from the same well cannot be split into different 

Groups. 

3. You can create >2 groups, but only 2 groups can be 

active for the Workspace at the same time. 

4. You do not have to configure >1 group to use fields 

images from different wells or experimental 

conditions/controls. You can put fields from very different 

wells into one group for simplicity, if ≤10 field will suffice 

for your purposes. But only 1 field can be displayed at a 

time (rather than the max of 2). Also, if you wish to use 

data visualizations (graphs or tables), you cannot see 

separate data from the pooled conditions. 

 

1. Scan software’s 2 modes for getting images:  

a. Live-mode Scan Setting: This is possible only when 

the software is running an instrument (i.e., NOT on a 

Toolbox). It’s not called “Live” because the samples 

are live cells, but because images are acquired from a 

live camera. 

b. Disk-mode (a.k.a., “disk scan” mode): Images from 

previous scans are loaded from a disk location, rather 

than the camera. This is the only possible mode on a 

Toolbox (i.e., not on instrument’s PC). However, the 

software on instrument’s PC can also be used in 

Disk scan mode, either by (a) launching the Scan 

software when the instrument is powered off, (b) using 

the camera button on the toolbar in Scan Plate view. (A 

3rd is via a Shortcut on the Desktop made by copying the Scan shortcut 

and editing its Properties to add –canned to the end of its Shortcut 

Target string; rename this copy to Disk Mode). 

2. Configure Assay Parameters: 1st step depends 

on mode: 

1. Live mode: Configure Assay Parameters task begins 

in Configure Groups dialog, from which you can 

choose the image sets of wells and fields you saved 

temporarily by the [Save Field] button in the Configure 

Acquisition task. 

2. Disk mode: Configure Assay Parameters task begins 

in Acquire Images, where the Source can be plates 

already in your Store database (expand Search 

Criteria if required/desired), or stored separately 

outside your database somewhere on Disk (change 

Source to Disk, and Change Directory… as 

needed). After select and Add Plate, you advance to 

the Configure Groups dialog, as for Live-mode. 

3. Whether in Live or Disk mode, you can add additional 

plates to the Configure Groups dialog using [Add] in 

the Plate pane of that dialog, if you want to configure 

groups using images from different plates/sources. 
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In the example above, note the Group Layout is 2 Groups. Only the bottom Group (Group 1) has been configured 

(Configure Groups dialog not shown). The “Workspace” is everything to the right of the Protocol Optimization Task List. 
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Image Preprocessing: 
Background Removal 

1. Always use it, whenever you can! And, when you can,… 

Best Practice:  

Use Fixed Threshold for Object Identification Method (if you can). 

2. When can I not use it? 

When any image may have near-confluent fluorescence (maybe):  

a. Imagine the Raw Image is full of objects; what would the blurred Background 

image look like? 

b. …And the Background Corrected Image?   

c. In sum, has to be some background in every image. Why?... 

3. Background Removal is a “global” Assay Parameter—i.e., when activated, it is 

performed on every image in that channel 

4. High impact on all aspects of processing & analyses 

a. Performed BEFORE Object Identification (except spots/neurites) 

b. All output feature values vary with Value (incl. spots/neurites) 

5. Can I see the Background-corrected images? Yes, use Configure Channels 

dialog. However, only the raw image is ever saved. (Background image can 

never be viewed.) 

6. Choosing a Value: Display the BGRemoved image at low Gamma 

a. “Aggressive” Values (low) ~ diameter of largest typical objects. (unit is 

pixels, so “bridge” across all fluorescence patches) 

a. for reliably monodisperse objects/signal. 

b. Aggressive low values afford “localized” correction 

b. “Conservative” (large Values) for heterogeneous objects/signals. 

a. Greater than 2x largest diameter? 

b. Heterogeneity too unpredictable? Consider Max Value (255) 

 

7. Choosing a Method: (see BioApplication Guides for illustrations) 

a. LowPassFilter 

i. Best for object identification channels. 

ii. Caution for intensity-critical channels because over-
corrects (often ~20%), so some true foreground signal can 
be lost. 

iii. Caution for unpredictable object sizes (like some colony 
samples). 

iv. Poor for dime edges of “whole cell” graded fluorescence. 

b. 3D_SurfaceFitting (do NOT use Values ≤ 32; ≥ 64 best) 

a. Best for intensity-critical channels (preserves foreground 
better than LowPassFilter, often under-correcting ~10%). 

b. Best for preserving dim edges of “whole cell” graded 
fluorescence. 

c. Poor for “dirty” samples (because so gentle, ascribes haze 
as BG). 

d. Caution: Values too low can cause unpredictable artifacts. 

 

Best Practice: Use whenever possible! 

Background image constructed essentially by blurring Raw Image. 

Value inversely proportional to how much blurring. NOT an 

intensity value itself—it’s spatial 
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• Activate Low Pass Filter method for Background correction and select a 

value: 

 

• In this example, for each pixel in the image an square area of 2x40 pixels 

large centered around this pixel will be defined.  

 

• The average intensity of this area is an estimation of the Bgnd level at this 

pixel and will be subtracted to the pixel intensity value 

 

• Eventually, it equivalent to subtract to the original image an image 

“smoothed” with a filter of a size of 81 pixels. Ex:  

How does the Background correction low-pass filter method 
work? 
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• Activate 3D-Surface Fitting method for Background correction and select a value: 

• In this example, the image will be virtually cut into squares of 2x80 pixels large 

• In each square, the background estimation will consist in picking the minimum intensity 

value 

 

 

 

• Think to a 3D plot where intensity at each point of coordinates X,Y could be 

represented as an altitude 

• The obtained surface will be smoothed (surface-fitting) and then subtracted to the 

original image to get the corrected image 

 

 

 

 

 

How does the surface-fitting method work? 

Prefer values that divide 512 (size of pictures in 

standard configuration) to get a strictly square cut-

out 

First background estimation Surface-fitted background image 
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Object Identification Methods & Values 

• Object Identification is, fundamentally, identifying foreground objects as patches of pixels that are 

brighter than background pixels. 

• An image comprises pixels;  each pixel has an intensity value. 

• A frequency distribution histogram of these pixel intensity values is called the 

“image histogram” and is one form of information in an image. 

• Does an image histogram represent spatial information from the image? 
• Analyze image histogram info  intensity threshold  identify objects as foreground vs. 

background.  Advantage: 

• 100’s or 1000’s of images from one assay have variations in foregrounds 

and/or backgrounds, so histograms vary from image to image. 

• Flexible, systematic method of analyzing each can still  comparable object 

identification results amidst the variations. 
• Method: IsodataThreshold 

• Assumes bimodal histogram, determines T by iteratively computing threshold between means on 

left (mL) and right (mR) sides of histogram until T does not change any more. 

• Good for bimodal histograms (expect every image to have similar densities of foreground 

objects?) 

• What happens in fields that are sparse, or fluorescence very low? 

• What happens in fields with bright fluorescent outliers, debris, or artifacts? 
• Method: TriangulationThreshold 

• On image histogram, hypotenuse “drawn” from mode (tallest peak) to max intensity. 

• T is value on x-axis where longest normal (perpendicular line) between 

hypotenuse & histogram’s curve occurs. 
• Good for potentially sparse fields. 

• What are possible outcomes when fields are potentially dense? 

• What are possible outcomes when fields have bright fluorescent outliers  

(consider size of such objects, and “tightness” [kurtosis] of their peaks)? 
• Method: 3sigmaThreshold-  calculated threshold is 3 standard deviations above the calculated Mean 

of the distribution. 

• Value: Shifts auto-computed threshold (Tcalc) according to equation below. 

mR 

mL 

Tfinal = Tcalc x (1+Value) 
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Object Segmentation in Object Identification 

Why only when you must? It’s an approximation, so subject to imperfections. 

1. When must I use it? 

a. When a prohibitive majority of cells are simply too crowded to identify individually, and 

individual identification is required. 

b. e.g. let your biological assay needs guide you. 

2. How else can I deal with clustered cells? 

a. Seed wells to achieve lower final densities, and/or more appropriately dispersed cells (some 

tips are provided in Cellomics’ FAQs). 

b. Use a different cell type, if possible (a handful of cell types are known for their tendencies to 

cluster; e.g., HEK293, HepG2, MCF7). 

c. Reject them using Object Selection Parameters. In such a case, weigh… 

i. [time to acquire more images] versus [risk of inaccurate Object 

Segmentation]; 

ii. whether Rejection of clusters introduces bias (e.g., target phenotype 

expressed only in clusters?). Compare results using [Object Selection 

Parameters that Reject all but single cells] versus [Rejection of only/mostly 

single cells]. 

3. What Method & Value should I use?  Determine empirically. Some guides… 

a. Shape: Best for clusters of 2 or 3 cells, where geometry of borders are visual cues.  

 Start Value ~radius (1/2 the diameter) of a typical Object. 

b. Intensity: Best for “whole cell” fluorescence, & maybe nuclear clusters of >2 or 3 cells. 

i. Use of Smoothing critical for avoiding over-segmentation. 

ii. Value easiest to determine empirically, but see illustrations in BioApplication 

Guide if interested. 

ObjectSegmentation : Just when you must! 

Image illustrates some 

caveats of 

ObjectSegmentation. 

Some of such debris 

segments can be 

Rejected if Object 

Selection Parameters 

are optimized, but not 

always. Also, other 

caveats less obvious 

include over-

segmentation of a large 

or elongated single 

object. 
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Object Segmentation 

• Shape (Classic = positive) – Value = radius (in pixels) of smaller object 

to segment 

 

 

 

 

 

• Intensity (Classic = negative) – Value = minimum relative height of 

intensity peak 

Segmentation = 7 

(radius of R3) 

  -1000                 -400          -100 
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Caveats & benefits of different Object Identification Methods and Assay 
Parameters 

Images show caveats of Isodata (or PeakTriang or other histogram-based, dynamic) Object 

Identification Methods, as well as a caveat of the ObjectSegmentation Assay Parameter, 

and a benefit of the Background Removal Assay Parameter. 
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Interactive graphical displays 

•  Secondary visualizations are possible, that enable the display 

of scatter plots, histograms and data tables. 

 

•  Tables and graphs directly interact with the image.  In this  

example, large nuclei (> 1 SD of the mean) were selected  

on the graph and identified by a red overlay on the graph. 

 

•  Graphical displays can be modified to show additional 

information (range, SD, etc.) using the configure icon.    
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Setting Reference Levels Manually 
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Subpopulation Characterization - Scan Limits 

2. Scan Limits pane, Intra-Well Stopping Criteria section: 

a. When will the ArrayScan stop scanning a well, and  

proceed to the next well? 

i. When at least one check-able Intra-Well Stopping Criteria is met or exceeded. 
b. A “Sparse Field” has fewer objects than the Min Objects For Field (always keep >0). 

c. Max Sparse Fields For Well: Sparse Fields must be contiguous to hit this limit. 

d. All Scan Limits can have dramatic impacts on scan time. Think through logic very carefully. 

e. How many objects is enough?  

i. Must be answered by assay developer’s statistical requirements, which can be arbitrary and 

vary between organizations..  

ii. Cellomics has some recommendations, but these are in the context of specific assay 

statistical requirements, arbitrarily selected, though common. 

iii.Here’s a Good Practice: 

Early in assay development, scan all possible fields in model wells to create a 

comprehensive, stored image set. Create a series of batch rescans using the Disk Scan 

Wizard (or ArrayScan software in Disk Mode) to rescan the images, where the only variable 

between scans is decrementing # of fields per well. Such a batch is programmed using Plate 

Protocols, where, in this case, the Plate Protocols differ only in one regard—their Assay 

Protocols differ only in Max Fields For Well, with all other Scan Limits boxes unchecked. 

Examine the results of such batches to determine a minimum sample size at which StdDev is 

stable for principal output well features.  

iv.NOTE: An “object” in the context of Scan Limits is BioApplication-dependent. 
3. Scan Limits pane, Intra-Plate Stopping Criteria section: 

What use is Max Sparse Wells For Plate?  

a. In mass sample prep operations (e.g., automation), if most cells are lost by unsuitable liquid handling or a 

treatment undergone by all wells, or a necessary labeling regent was not suitably applied… 

b. When scanning a stack of plates, more efficient not to scan “bad” plates. 

 

1. Subpopulation Events and Reference Wells: Advanced topics; see BioApplication Guides. 
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Setting Events 

• Boolean operation 

• Defining a subpopulation by using any 

combination of cell features  

• Reporting characteristics of your subpopulations 

• Event definition is achieved through the 

construction of logic statements employing 

upper levels for specific Cell Features and a set 

of defined logical operators.  

• ANDNOT and ORNOT are obtained by combining 

AND + NOT and OR + NOT respectively.  
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Select Features to Store 

Features To Store: If they are not selected for your protocol, they will not be stored as data. (You can subsequently disk 

scan images after saving a protocol version in which more features are selected to store.)  Use the filters for efficiency. 

For example, if you have not set Reference Levels meaningfully, Omit “status” and “event” in Cell Features, and 

%HIGH, etc. in Well Features. 

Over extended use of your system, your database can grow large quickly if you save many Cell Features for screens. 

You may wish to save few or no Cell Features in large screens? (Well Features do not consume substantial database 

space.) 

Display Settings: When you review data and images, the overlays and composite colors selected here will be stored – 

NOT the overlays and colors used in prior tasks of iDev Protocol Optimization. 
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Reviewing results in vHCS:View 

Launch via Start> Program Files> Cellomics> 

vHCS:View 

A. Highly developed software with user-friendly GUI 

(graphical user interface): 

1. Almost complete redundancy between menus, 

toolbar icons, and right-click context-sensitive pop-

up menus. 

2. Uses Windows conventional Ctrl+click & Shift+click 

functions for selections on text lists, spreadsheets, 

etc. 

3. Uses Windows conventional Ctrl+C (copy) & Ctrl+V 

(paste) from spreadsheets. 

4. Full on-line Help menu. 

B. Best Practices – Tips for fast, easy use & learning 

1. Frequently right-click on GUI elements (graphs, 

images, diagrams, spreadsheets) for command 

options on single GUI elements. 

2. Use the Windows menu on the menu bar for 

managing arrangements of multiple windows/views 

and navigating between them. 

3. Check menu bar menus for additional command 

options, and when multiple GUI element types are 

displayed (e.g., a view with multiple graphs). 

4. Notice the interconnections of interactive GUI 

elements (e.g., click a point on a graph, and note 

spreadsheet highlight changes with it). 

5. Be fearlessly exploratory—except for Delete 

Plate(s). Aside from Delete, you cannot change any 

data using vHCS:View: It’s only a tool for viewing 

data in different ways. 

Find a Plate result of interest: 

• Well Details 

• Row/Col mode (so lay out plates accordingly) 

• Use down arrow key to “flip” through Feature list 

• double-click anywhere on graph (except points) to 

Customize 

• Copy/export spreadsheets or graphs 

• Methods (bar, points, points+lines) 

• File> Report 

• Cell Details 

• toggling overlays 

• Maximize images (and de-max to restore; don’t click  or 

Cell Details closes) 

• making New plots 

• hidden graphs B & C 

• scatter vs histograms 

• maximize, copy, export spreadsheets/graphs 

• select spreadsheet column heading, right-click, Sort…, 

useful to find where to use subpop cutoffs or other assay 

params, as are histograms/scatter plots. 

• show can call Cell Details from multiple highlighted Well 

Details wells (contiguous) 

Other common uses besides Well & Cell Details: 

• Multi-Plate View 

• Graph menu> Plot on Single Graph 

• Spreadsheet menu> Export to… 

• Multi-Feature View 

• Graph menu> Plot on Single Graph (only good for similar 

scales, and rough with multiple rows) 

• Spreadsheet menu> Export to… 
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Plate Protocols 

Plate ID / Barcode (when) 

Plate Protocol (where) 
Remaining scan settings not in Assay Protocol: 

• Plate Type (Form Factor) 

• Scan Area (which wells on plate) 

• Starting Field Offset (within each well) 

• Store Images (saves space for quick tests) 

• Display More (reduced GUI graphics; reduce time) 

Assay Protocol (what/how) 
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“Rejected” Overlays – multiple reasons 

“1° object mask” 

MaskModifierChN 

(Assay Parameter) 

Object Selection 

(a.k.a. “gating”) 

Selected_ 

1° Object Identification 

1° Object Validation 

includes 

 1° Object Selection 

“1° objects” 

with 

 “1° masks” data results 

“Rejected_” overlay (usually*). 

• If “Rejected_” because of 1°Ch, 

• excluded from Valid_Count 

•  from Selected_Count 

•  from %Selected_ 

• If “Rejected_” because of 2°Ch, 

• included in Valid_Count 

• excluded from Selected_Count 

• reflected in %Selected_ 

( =  Selected_    Valid_Count) 

* BioApp-specific (a few cases  

have no “Rejected_” overlay). 

Also, overlay must be . 

fail fail 

“2°/sub-object masks” 

Object Identification 

(often + Assay Params) 

Sub-Object Selection 

(same list ) 

overlay 
no overlay 

2° channels 
(a.k.a. “downstream/dependent”,  “ChN”) 



42 

Appendix III: Starting up the VTI Live Cell Chamber (LCC) hardware 

Your live cell chamber has been calibrated to your laboratory conditions.  Physical 

adjustments to the settings on the CT controller are therefore not required, nor 

recommended. 

• DAILY SETUP:  start at least 45 minutes before you plan to put cells into the chamber 

•  t = -45’ 

• Switch on CT unit: Green switch on front of CT unit. 

• Distilled H2O level in humidifier (500mL bottle) 200-400 mL (>450mL may bubble into gas 

inlet and contaminate chamber.) 

• Make sure flow valve in lower left of CT unit is OPEN. 

• Start CO2 flow into CT mixer from 100% source supply. 

• Open regulator at source gradually, because H2O begins bubbling. 

• Check CO2 settings: 

• From regulator:  Max 15 psi, or 1 bar. 

• On CT controller Unit: CO2 flow should be ~1.8 LPM; check silver bubble within clear 

acrylic gauge embedded in CT unit. 

• Use knob at bottom of gauge to adjust if necessary.  NEVER shut down this valve 

completely. 

• Open ArrayScan software:  LCC status is shown at bottom right of window.  If you do not 

see status boxes, follow steps in blue text at right. 

•  t = 0 

• Use the ArrayScan software (Tools> Configure Live Cell Chamber…) to adjust 

temperature and CO2, if necessary. 

• LCC shut-down 

• Close the ArrayScan Software by using File…Exit. 

• LCC Control Unit power can be switched off while ArrayScan remains on. Leave the flow 

valve as is. 

• Stop the CO2 supply at its source. 

1. Go to Tools…Configure Live Cell 

Chamber and click Enable.  If grayed 

out,  

2. Close AS software, then go to 

C:/program files/Cellomics/Tools/ 

customer tools/ArrayScanConfig.exe 

to make sure the LCC hardware is 

enabled.  Check the boxes for both 

temp and CO2, Save configuration. 

3. Once this is done, you will get a 

message if you start AS software with 

the LCC Controller powered off.  Just 

hit OK if you don’t want to use the 

LCC.  To avoid the message you have 

to go to this configuration tool again 

to disable it, then en able it again to 

use. 

CT controller 

Flow valve 

Power switch 


